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1 How to get Minidump Browser

Minidump Browser is free for commercial use. Minidump Browser can be downloaded for Software
Verify's website at https//www.softwareverify.com/product/mmidump-browser/.

This help manual is available in Compiled HTML Help (Windows Help files), PDF, and online.

Windows Help https://www.softwareverify.com/documentation/chm/miniDumpBrowser.chm
PDF https://www.softwareverify.com/documentation/pdfs/miniDumpBrowser. pdf
Online https://www.softwareverify.com/documentation/html/miniDumpBrowser/index.html

Whilst Minidump Browser is free for commercial use, Minidump Browser is copyrighted software and is
not in the public domain.

You are free to use the software at your own risk.

You are not allowed to distribute the software in any form, or to sell the software, or to host the software
on a website.

Contact
Contact Software Verify at:

Software Verify Limited
Suffolk Business Park
Eldo House

Kempson Way

Bury Saint Edmunds
IP32 7AR

United Kingdom

email  sales@softwareverify.com

web https://www.softwareverify.com

blog https://www.softwareverify.com/blog
twitter  http://twitter.com/softwareverify

Visit our blog to read our articles on debugging techniques and tools.
Follow us on twitter to keep track of the latest software tools and updates.
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What does Minidump Browser do?

2 What does Minidump Browser do?

Minidump Browser allows you to manage and identify minidumps on your machine, or your network.

Options are provided for advanced filtering of minidumps and to launch debuggers and minidump
visualisation tools.

32 bit and 64 bit

32 bit and 64 bit miniDumps are supported.
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Menu 7

3.1

3.2

Menu

The main menu contains three menus, File, Software Updates and Help.

[ Minidump Browser x64
File Software Updates Help

File

The File menu controls the scanning and display of minidumps.

Load minidumyp...

Load minidump ignoring failures...
Exit
File menu * Load minidump... * loads a minidump and displays it.

If the minidump is the wrong bit depth (32 bit when running 64 bit, or vice versa) then the other version of
Minidump browser is started to display the minidump.

If any errors occur when trying to load the minidump, the load fails. This means that mindumps from
ARM, IA64 and other architectures can't be displayed.

File menu * Load minidump ignoring failures... *» loads a minidump and displays it.

If the minidump is the wrong bit depth (32 bit when running 64 bit, or vice versa) then the other version of
Minidump browser is started to display the minidump.

If any errors occur when trying to load the minidump, the load fails to load just the failing part of the
minidump and continues with other parts of the minidump.

This means that mindumps from ARM, IA64 and other architectures can be displayed, but may have
incomplete information.

File menu * Exit * closes Minidump Browser.

Software Updates

The Software Updates menu controls how often software updates are downloaded.

If you've been notified of a new software release to Minidump Browser or just want to see if there's a new
version, this feature makes it easy to update.

Copyright © 2020-2023 Software Verify Limited
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Check for software updates...
Configure software updates...

Set software update directory...

E Software Updates menu * Check for software updates * checks for updates and shows the
software update dialog if any exist

An internet connection is needed to be able to make contact with our servers.

E Before updating the software, close the help manual, and end any active session by closing
target programs.

If no updates are available, you'll just see this message:

Check for software updates. >

o Mo new updates are available for Minidump Browser

Software Update dialog

If a software update is available for Minidump Browser you'll see the software update dialog.

Software update download confirmation H

A software update is available for Minidump Browser.

Do you wish to install Minidump Browser V1,507

Yes, Download and Install Don't download, ask me later Skip this version, don't tell me about it again

Software update

Software update options...

e Download and install > downloads the update, showing progress

Downleading Minidump Browser 1,30 *

Downloading Minidump Browser 1,50

5848 KB of 16656 KB (35.1%)
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Once the update has downloaded, Minidump Browser will close, run the installer, and restart.
You can stop the download at any time, if necessary.

e Don't download... * Doesn't download, but you'll be prompted for it again next time you start
Minidump Browser

e Skip this version... * Doesn't download the update and doesn't bother you again until there's an
even newer update

e Software update options... > edit the software update schedule

Problems downloading or installing?

If for whatever reason, automatic download and installation fails to complete:
e Download the latest installer manually from the software verify website.

Make some checks for possible scenarios where files may be locked by Minidump Browser as follows:
e Ensure Minidump Browser and its help manual is also closed
e Ensure any error dialogs from the previous installation are closed

You should now be ready to run the new version.

Software update schedule

Minidump Browser can automatically check to see if a new version of Minidump Browser is available for
downloading.

E Software Updates menu * Configure software updates * shows the software update schedule
dialog

The update options are:

never check for updates
check daily (the default)
check weekly

check monthly

The most recent check for updates is shown at the bottom.

Copyright © 2020-2023 Software Verify Limited
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Software update schedule ? et

OutputDebugStringChedker can check for software updates on a regular basis.,
" Mever check for updates
(" Check for updates every day
* Check for updates once a week

(" Chedk for updates once a month

Most recent check for updates was performed on 2022-07-23

QK | Cancel

Software update directory

It's important to be able to specify where software updates are downloaded to because of potential
security risks that may arise from allowing the Tme directory to be executable. For example, to
counteract security threats it's possible that account ownership permissions or antivirus software blocks
program execution directly from the Tvp directory.

The Tvp directory is the default location but if for whatever reason you're not comfortable with that, you
can specify your preferred download directory. This allows you to set permissions for Tmp to deny
execute privileges if you wish.

E Software Updates menu * Set software update directory * shows the Software update
download directory dialog

Software update download directory

? *
Software updates will be downloaded to the location spedfied below:
| C:\Users'stephen\AppDataLocal {Temp! Browse. ..

Reset

K | Cancel |

An invalid directory will show the path in red and will not be accepted until a valid folder is
entered.

Example reasons for invalid directories include:

o the directory doesn't exist
o the directory doesn't have write privilege (update can't be downloaded)
¢ the directory doesn't have execute privilege (downloaded update can't be run)

= when modifying the download directory, you should ensure the directory will continue to be valid.
Updates may no longer occur if the download location is later invalidated.
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o Reset » reverts the download location to the user's Tvp directory

The default location is c:\users\ [username] \AppData\Local\Temp

3.3 Help

The Help menu controls displaying this help document and displaying information about Minidump
Browser.

About Minidurmp Browser...
Readme and Version History...

Help Topics...
Help POF...

Help on softwareverify.com...

Blog...
Library...

Contact customer support...

How do 7.

Help menu > About Minidump Browser... * displays information about Minidump Browser.
Help menu * Readme and Version History... » displays the readme and version history.
Help menu > Help Topics... » displays this help file.

Help menu > Help PDF... > displays this help file in PDF format.

Help menu > Help on softwareverify.com... » display the Software Verify documentation web page
where you can view online documentation or download compiled HTML Help and PDF help documents.

Help menu *» Blog... *> display the Software Verify blog.

Help menu » Library... » display the Software Verify library - our best blog articles grouped by related
topics.

Help menu > Contact customer support... * displays the options for contacting customer support.
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Contact Software Verify Customer Support *
We provide customer support via email.

Email allows us to exchange detailed bug descriptions, detailed instructions, screenshots, log
files, crash dumps and other metadata that can't easily be communicated via telephone ar chat.

Should your support request require escalation to phone, Zoom or remote computer access we
will do that when required.

There are two methods to start a support request:

Email:

support@softwareverify.com

Website customer support form:
https: /fwww  softwareverify, com/suppart.php

Close

Click a link to contact customer support.

Help menu * How do I?... > displays the options for asking us how to do a particular task.

How do |7 »

How do I fly to the moon?
How do I make a purple cow?
How do I do X¥Z with Minidump Browser?

We can't help with the first two questions, but I think we can help with the last question.
we'l give you step by step instructions and/or a video showing you how to do XYZ,

Just send us an email describing what you're trying to do and we'll get right bacdk to you with a
solution,

Start a Support Reguest

Emiail:

support@softwareverify.com

Website customer support form:
https: /fwww . softwareverify, com/suppart/

Close
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4.1

The user interface

The Minidump Browser user interface is shown below.

When a minidump contains an exception the exception display will be automatically selected as the first

display to show you information.

['] Minidump Browser x86 - [} X
File Help
| summanry]| ] Flename:  C:Users\Stephen\AppData'Local\CrashDumpsideveny. exe. 12604.dmp
Comments
Excention Executable:  C:\Program Fies (x36) Microsoft Visual Studio 10,0Common7\IDE \deven. exe
Handles " -
Handle Operation Command Line: | C:\Program Files (xB6)Microsoft Visual Studio 10.0\Common7\IDE \deveny. exe
Memory " :
Memary Info Operating System: 10,0 Build 18363 (Windows 10)
Mis¢ Info Date:  2020/06/23 12:37:22
Moduies
Tokens Dump Flags: ithDataSegs, MinDumpiitht
Threads
Thvead Info Stream (22) | status (9) | RvA Size
Thread Names Exceptionstream Present 0x00000645 165 B
SystemInfo MemontistStream Present  0x000214F2 51.07KB
System Memary [nfo
Unloaded Modules MiscnfoStream Present x000000F4  1.33 KB
WM Couniters ModuleListStream Present OnDODOOBED  33.96 KB
ProcessVmCountersStream  Present 000009764 152 B
SysteminfoStream Present Ox000000BC | 56 B
SystemMemaorylnfoStream Present Ox00009578 492 B
ThreadListStream Present Ox000006F0  1.22 KB
UnloadedModulelistStream  Present xDO0093BC 444 B
CommentStreama

The display shows a summary page and then one page per logical group of data in the minidump. This
means that some discrete sections in the minidump have been coalesced - for example
ThreadListStream and ThreadExListStream are both represented in the Threads page. Each page is
listed on the left hand side. Selecting that entry displays the page on the right hand side. The summary
page lists each stream so that you can see which streams are present in the minidump and which are
absent. Few minidumps (if any) contain all streams.

Summary

The Summary page displays general information about the minidump, plus a list of all possible streams
and data about streams that are present.

Copyright © 2020-2023 Software Verify Limited
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['] Minidump Browser x26 - [} x
File Help
] Filename:  C:\Users\Stephen|AppData'f ocal\CrashDumps\deveny.exe. 13348, dmp
;m Executable:  C:\Program Fies (x86) Microsoft Visual Studio 10.0\Common7\IDE \devenv.exe
m::’ow“ " CommandLine:  "C:\Program Files (x86) \Microsoft Visual Studo 10.0\Commen7\IDE \deveny. xe” Copy
:m: e Operating System: 10,0 Build 18363 (Windows 10)
Misc Info Date:  2020/06/24 10:38:07
Modules
Tokens Dump Flags: ¥ ithDataSegs, MinD
Threads
e oo Stream (22) | status (9) | RvA Size
Thread Names ExceptionStream Present 0x00000646 168 B
::m Ip:;"uy o MemoryListStream Fresent Ox00020EA4 47,35 KB
Undoaded Modules MiscinfaStream Present Ox000000F4 133 KB
VM Counters ModuleListStream Present Ox0O000BB0 | 33.86 KB
ProcessVmCountersStream  Present 0x00009878 152 B
SysteminfoStream Present 0x000000BC | 56 B
SystemMemaryinfoStream | Present Ox0000968C 492 B
ThreadListStream Present OxDQ0006F0 | 1,13 KB
UnloadeaModuleListstream  Present Ox000092F0 924 B
CommentStreama

For each stream that is listed we indicate if the stream is present, the RVA (the offset from the start of
the minidump) to the stream and the size of the stream.

If you want to see the complete command line (for the cases when it's too long to display) use the Copy
button to copy the command line to the clipboard.

Command Line

To display the command line the minidump must contain Thread Info and memory data. The Thread Info
is used to locate the Thread Environment Block, which is then used to locate the Process Environment
Block, which is then used to read the command line.

42 Comments

The Comments page displays the contents of the CommentStreamA and CommentStreamW minidump
streams.

Copyright © 2020-2023 Software Verify Limited
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4.3

[ Minidump Browser x86
File Help

Summary
Exception
Handles

Handle Operation
Memaory

Memary Info
Misc Info
Modules

Tokens

Threads

Thread Info
Thread Names
System Info
System Memary Info

VM Counters

Exception

The Exception page displays the contents of the ExceptionStream minidump stream.

A few extra fields are displayed to provide additional information: Exception Symbol, Exception
Filename, Exception DLL.

[ I] Minidump Browser x86
File Help

Summary
Comments
Handles

Handle Operation
Memory

Memoery Info

Misc Info

Modules

Tokens

Threads

Thread Info
Thread Names
System Info
System Memary Info
Unloaded Modules
VM Counters

[ copyText | | copyEventViewer | | DbgHepBrowser.. || DWARFBronser... | | TDSErowser.. | MAP File Browser...
Name Value Raw Value

Thread id 13168

Exception code STATUS_ACCESS_VIOLATION Oxc0000005

Exception flags Continuable 0x00000000

Exception record 0x00000000

Exception address Ox766E9365

Exception Symbol memmaove

Exception Filename

Exception DLL msvert.dil CAWindows\System32\msvert.dll

Number of parameters
Exception information

Context

2
Read from memaory address 0x927316D0

Flags: CONTEXT_CONTROL, CONTEXT_INTEGER, CONTEXT_SEGMEN

Info: 0x00000000 0x927316D0

0x0001007F

Copy Text

Copy Text copies the text from the grid to the clipboard.

Each column is separated with a comma. Each line is separated by "\r\n".
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Copy Event Viewer

Copy Event Viewer copies the exception data to the clipboard in the same format as the Windows Event
Viewer. You can paste this data into some of our other tools (Minidump Browser, MapFile Browser, TDS
Browser).

An example of the data is shown below for an Access Violation at 0x0c18459c in devenv.exe.

<Event>

<System>
<Provider Name="Windows Error Reporting">

</System>

<EventData>
<Data></Data>
<Data></Data>
<Data>APPCRASH</Data>
<Data></Data>
<Data></Data>
<Data>C:\Program Files (x86)\Microsoft Visual Studio 10.0\Common7\IDE\devenv.exe</Data>
<Data></Data>
<Data></Data>
<Data></Data>
<Data></Data>
<Data></Data>
<Data>0xc0000005</Data>
<Data>0x0cl18459c</Data>
<Data></Data>
<Data></Data>
<Data>STATUS_ACCESS_VIOLATION</Data>
<Data>OK</Data>
<Data></Data>

</EventData>

</Event>

Tools

If you hawe installed Minidump Browser, DWARF Browser, TDS Browser, MAP File Browser, the
appropriate button to launch this tool will be enabled.

Launching the tool will attempt to load the appropriate PDB, DWARF, TDS, MAP data and then locate
the symbol that matches the exception crash address.

4.4 Handles

The Handles page displays the contents of the HandleDataStream minidump stream.

Copyright © 2020-2023 Software Verify Limited



18

MiniDump Browser Help

4.5

['] Minidump Browser x26 - O *

File Help

[ summary Handle  Type Object A

Comments _j

Exeention 0600000254 | Section \Windows\Theme2284735901
0x00000124 WindowStation \Sessions\2\Windows\WindowStations\WinStal

Handie Operation 0x0000011C | WindowStation \Sessions\Z\Windows\WindowsStations\Winstad

Mermr

¥

Memary Info Ow00D0025C | Section ‘\Sessions\2\Windows\Theme620801168

Misc Info Ox0000023C | Section ‘\Sessions\2\BaseNamedObjects\windows_shell_global_counters

Modules

Tokens Ox00000640 | Section ‘Sessions\2\BaseNamedObjects\SessionimmersiveColorPreference

Threads 0xDO0D0E38 | Mutant \Sessions\2\B: olorhutex

Theead Info OxD0000364 | Semaphore \Sessions\2\BaseNamedObjects\SMO:9816:64/WilError_02_p0

Thread Names

System Info 000000360 Mutant \Sessions\2\BaseNamedObjects\SMO:9816:64WilError_02

System Memory Info 0x00000260 Semaphore ‘Sessions\2\BaseNamedObjects\SMO:9816:1658:Wilstaging_02_p0

Unloaded Modules - . . e

VM Counters Ox00000258  Mutant Sessions\2\BaseNamedObjects\SMO:9816:168:Wilstaging_02
0x00000624 Section ‘Sessions\2\BaseNamedObjects\C:*ProgramData*Microsoft*Windows*Caches*[DDF571F2-BES8-426D-8288-1A9A39C3FDAZ]. 2. ver
On0000061C | Section ‘Sessions\2\BaseNamedObjects\C:*ProgramData*Micros oft*Wind, aches*[6AF D558-4FGE-9B3C-37166804F483}).2 verl:
OD0000CCC | Section ‘Sessions\2\B: ProgramData*Microsoft ach 2.0
000000620 Section \Sessions\2\BaseNamedObjects\C:*ProgramData* Mierosoft*Windows* Caches* eversions.2.ro
Ox000D0618 | Section \Sessions\2\BaseNamedObjects\C:*ProgramData*Micros oft*Windows*Caches*cversions.2.ro
Cx0000043C | Section ‘\Sessions\2\| Objects'\2DefaultTIP ¥ v
< >

For each handle that is present in the dump the following information is displayed:

Handle
The handle value.

Type
The handle type.

Object

The name of the object referenced by the handle.

Attributes
The attributes of the handle.

Granted Access
Access rights to the handle.

Handle Count
Number of references to the handle.

Pointer Count
Object specific count.

Object Info
Extra information about the object.

Reserved0

Handle Operation

The Handle Operation page displays the contents of the HandleOperationListStream minidump stream.
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[ Minidump Browser x86
File Help

Summary
Comments
Exception
Handles

Memaory

Memary Info

Misc Info

Modules

Tokens

Threads

Thread Info
Thread Names
System Info
System Memary Info
Unloaded Modules
VM Counters

Handle | Process|d | Thread Id OporaﬂonTypo|Badmau

Handle operation information relates to information collected by Application Verifier.

More information here: https//docs.microsoft.com/en- gb/windows/win32/api/miidumpapiset/ns-
minidumpapiset-minidump handle operation list

Memory

The Memory page displays the contents of the MemoryListStream and the Memory64ListStream

minidump streams.

[ Minidump Browser x86

File Help

Sumenary Start Add...

Comments

Exception On02CDFT08

Handles OMDOESFE14

Handle Operation ATSETEAD

Memory Info OxDBB3FA24

Misc Info OMOBASFCS0

Modules

Tokens (Ox0614FB63

Threads 009CIFCEY

Thread Info DNTB46287C

Thread Names

System Info Ox02B9FB64.

System Memary Info Owl858FE44

Unloaded Modules Ox0S89FDAS

WM Countters
OnD32EFCFO
(dDSEEFATD
OnOTEGFAD.
Ox00DSFDSC
OxD34EFE14.
Ow0B00F4CC
OX0BTEFA24
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4.7

4.8

The information presented here is a list of memory start addresses and the size of the memory at that
address.

Memory Info

The Memory Info page displays the contents of the MemoryInfoListStream minidump stream.

['] Minidump Browser x86 - O X
File Help
Summary Base Address , | Allocation Base | Region Size | Allocation Protect | State | Protect Type B
Exception Cx0O000000 OD0000000 5.38 MB Free Ho Access
Handles 000560000 000560000 64,00 KB| Read, Write Commit | Read, Write Mapped
::::yooeraﬁm 0x00570000 Ox00570000 20,00 KB Read, Write Commit | Read, Write Private
000575000 0x00570000 36.00 KB| Read, Write Reserve Private
Mis¢ Info OxDOSTEDOD OxDDO0DDOO 8.00 kB Free o Access
_':;:‘: 000580000 00530000 16.00 KB| Read Only Commit | Read Only Mapped
Threads 000584000 000580000 16.00 KB| Read Only Reserve Mapped
Theead Info 0x00588000 0x00000000 32.00 KB Free | NoAccess
Thread Names
Syetem Info Ox00590000 000530000 108,00 KB Read Only Commit | Read Only Mapped
System Memory Info Ox005AB000 000000000 20,00 KB Free Mo Access
3:?:;"[::6” Ox005B0000 0x005B0000 176.00 KB Read, Write Reserve Private
OxD0SDC000 OxD05BO000 12.00 KB| Read, Write Commit | Guard, Read, Write | Private
Ox005DFO00 CD0SBO00D 68,00 KB| Read, Write Commit | Read, Write Private
Ox005FO000 ODOSFO000 980,00 KB| Read, Write Reserve Private
OxO0SES000 OwD0SFO000 8.00 KB| Read, Write Commit | Guard, Read, Write | Private
Ox006ET000 OxDOSFOD00 36.00 KB Read, Write Commit | Read, Write Private
Ox006F0000 OeDOEFO000 16.00 KB Read Only Commit | Read Only Mapped
Ox0OEF4000 00000000 48,00 KB/ Free No Access v

The information here allows you to inspect the memory protection status of areas of memory in the
minidump.

If you'd like to view this information in graphical form you can also use VM Validator. VM Validator views
memory data in live processes and minidumps.

Misc Info

The Misc Info page displays the contents of the MiscInfoStream minidump stream.
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['] Minidump Browser x26 — o <
File Help
Summary Name Value Raw Value e
Comments
Exception Flags MINIDUMP_MISC1_PROCESS_ID, MINIDUMP_MISCT_PROCESS_TIME | CnD00003(T
Handles
Handle Cperation Process
Memaory
Memary Info Process id 12952
Create Time 2021/01/02 20:51:02 1609620662
Modules
Tokens User Time s 7
Threads Kernel Time 168 16
Thread Info
Thread Names
System Info Processor
System Memory Info Max Mhz 4001 Mhz 4001
Unloaded M Current Mhz 40071 Mhz 400
VM Counters
Mhz Limit 4001 Mhz 4001
Max Idle State 2
Current Idle State 2
Integrity
Integrity Level 8192 "
< >

This section provides miscellaneous information about the minidump application.

4.9 Modules

The Modules page displays the contents of the ModuleListStream minidump stream.

[ Minidump Browser x5 - O X
File Help
[ sumenary Display modue path
Comments
Exception Image ... Size Check Ti P File Versi: Product Version | Attributes Meodule ~
Handles 0x00T90000, 120.00 KB 0x00022496 2020/01/22 22:16:24 1.0.01 1.0.0.1 Application Ehomi\cite
Handle Operation Ox76F30000 1.60 MB 0x00198081| 2057/04/04 08:25:38 6.2.18362.387 10.0.18362.387 DLL CAwindou
:m; nfo ON76380000) B96.00 KB  Ow000ASt05 2035/07/27 02:33:32 6.2.18362.329 10.0.18362.328 DLL C\Windou
Mise Irfo 076010000 1.98 MB 0x0020113e  2018/10/31 16:59:14 6.2.18362.535 10.0.18362.535 DLL C\Windov
Tokens Ox56060000, 636.00 KB O0x000aB3e3  2049/12/15 11:26:05 6.2.18362.1 10.0.18362.1 DLL C\Windov
Threads Ox74720000 1.59 MB 000120537 2034/09/01 06:00:28 6.2.18362.592 10.0.18362.592 DLL C\Windov
Theead Info ON76460000  9200KB 000025850 2063/01/10 11:30:25 6.2.18362.592 10.0.18362.592 Application CWindey
;‘:::::‘mes Ox76480000 132.00 KB x00020rce 2013/11/10 16:08:31 6.2.18362.1 10.0.18362.1 DLL Ciwindov
System Memory Info ON765600000 1.35MB|  Ox00152928 2064/09/22 19:13:00 6.2.18362.535 10.0.18362.535 DLL CWindo
Unioaded Modules Ox73F 10000 1.56 MB OuD0176cce . 2057/11/21 05:47:39 6.2.18362.1 10.0.18362.1 DLL C\Windov
M Countere Ox76810000) 496.00KB|  Ox0007dOGE | 2008/01/12 20:33:10 6.2.18362.387 10.0.18362.387 DLL CWindoy
Ox75A40000 1.12MB  x0012252b 2028/05/06 23:52:30 6.2.18362.387 10.0.18362.387 DLL CiWindov
OxGEAADODD Z06MB  (x00216ded 2046/10/25 03:48:08 6.10.18362.592 10.0.18362.592 DLL CAwindo
Ox74B60000  764.00 KB OnD00C7868 2017/03/07 14:39:08 7.0.18362.1 10.0.18362.1 Application Cwindo
O745C0000)  246MB  Ox002781d1| 2045/09/08 04:09:04 6.2.18362.449 10.0.18362.448 DLL Cwindo
OM769A0000) T74B00KB  OwO0OC2c99| 2035/04/14 09:08:11 6.2.18362.476 10.0.18362476 DLL CiWindot
< >

For each module in the minidump this page displays the following information, dll load address (image
base), size, checksum, timestamp, file version, product version, application attributes and module name
(with optional path).
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410 Tokens

The Tokens page displays the contents of the TokenStream minidump stream.

['] Minidump Browser x36 _ O ®
File Help

Summary Token Id /| Token Handle
Comments
Exception

Handles

Handle Operation
Memaory

Memory Info

Misc Info

Modules

Threads

Thread Info

Thread Names
System Info

System Memary Info
Unloaded Modules
VM Counters

0x00002658  0x0000000000000e34

411 Threads

The Threads page displays the contents of the ThreadListStream and ThreadExListStream minidump

streams.
['] Minidump Browser x86 - O e
File Help
Summary Threa... . | Thread Name | Suspend | Priority Class | Priority | TEB Stack Stack Size | Context -
Exception 7840 CareateMiniDumpAppMainThread 0 Nomal 0| Ox0088E000 OXOOGEE13C 7,69 KB| Flags: CONTEXT_CONTROL
Handies 2264 © Nomal | 0| 0x00891000| Ox00DSFDSC 676 B/ Flags: CONTEXT_CONTROL
mo"”"’“‘ 1548 Nermal 0| 0x00834000 OXOOESFB14 1.23 KB Flags: CONTEXT_CONTROL
m: Info 24 0 Normal | 0| 0x00857000 OXDOFSFCFO 784 B Flags: CONTEXT_CONTROL
Misc Info 22292 Second Thread 0 Nomal 0| Ox0089A000  OXO32EFCFO 784 B| Flags: CONTEXT_CONTROL
m 19376 Third Thread 0 Nomal | 0| 0x0089D000 04033815 1,88 KB Flags: CONTEXT_CONTROL
17020 Fourth Thread Normal 0| OxD08AD000 OND34EFE14 492 B Flags: CONTEXT_CONTROL
Thread Info 13012 Fifth Thread 0 Normal | o| 0x008A3000 0x03SEFEAD 352 B| Flags: CONTEXT_CONTROL
:;‘::r;“ 1916 0 Nomal 0| ONOOSAG000 OXOZBIFBE4 1,90 KB| Flags: CONTEXT_CONTROL
System Memory Info 22480 0 Nomal | 0| 0:00842000 Cx02CDFT08 2.24KB| Flags: CONTEXT_CONTROL
m;:‘h 5908 0 Nomal 0| (0x00882000 OXDBOOF4CC 2.80KB| Flags: CONTEXT_CONTROL
1592 0 Nomal | 0| 0x008B5000 (x0514FBEB 1.15 KB Flags: CONTEXT_CONTROI
20696 0 Nomal 0 (x008BS000  OxDE28FDES 664 B| Flags: CONTEXT_CONTROL
22108 0 Nomal | 0| 000868000 OXOTEGFADS 1.29 KB Flags: CONTEXT_CONTROL
22328 Normal 0| Ox008C4000 OXOTFEFGSC 2.41KB| Flags: CONTEXT_CONTROL
21084 0 Nomal | 0| oxoscrooo mxos7EFAZd 1.46 KB Flags: CONTEXT_CONTROL
17724 0 Nomal 0 OxDOBCADOD (wDBBEFA24 1,46 KB Flags: CONTEXT_CONTROL .,
< >

For each thread the following information is displayed: thread id, thread name, if the thread is suspended,
it's priority class, it's priority level, the thread environment block (TEB) address, the stack location and
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size and the flags used to create the thread context, plus a dump of some thread context members
(processor registers etc).

412 Thread Info

The Thread Info page displays the contents of the ThreadInfoListStream minidump stream.

['] Minidump Browser x86 - O ®
File Help
m‘;ﬁ Threa... | | Thread Name Dump Flags Dump Error Exit Status | Create Tim
Exception 7840 CereateMiniDumpAppMainThread | This thread called MiniDumpWriteDump( | The operation completed successfully, 00000103 2020/01/23 0F
Handles 2264 The operation completed successtully. 0000000103 2020/01/23 0
::’m'd:yo"e"’"m 1548 The operation completed successtully, 0K0D000103. 2020/01/23 0F
Memary Info 22224 The operation completed successfully. 000000103 2020/01/23 0€
Mis¢ Info 22292 Second Thread The operation completed successfully. 00000103 2020/01/23 0F
_r:;::‘:s 1837& Third Thread The operation completed successiully, 00000103 2020/01/23 0
Threads 17020 Fourth Thread The operation completed successfully. 000000103  2020,/01/23 0
13012 Fifth Thread The operation completed successfully. Ga00000103 . 2020/01/23 0
Thread Names
System Info 1916 The operation completed successtully, 00000103 2020/01/23 0
System Memary [nfo 22480 The operation completed successtully. Ox00000103  2020/01/23 02
t'g?:fm’::d"es 5908 The operation completed successfully.  0x0D000103 2020/01/23 0%
1992 The operation completed successfully. 0D000103 . 2020,/01/23 0
20696 The operation completed successfully, 00000103 2020/01/23 O
22108 The operation completed successfully, 0x00000103  2020/01/23 0F
22328 The operation completed successtully, On00000103  2020/01/23 0
21084 The operation completed successfully. (00000103 2020/01/23 0C
17724 The operation completed successfully, 000000103 2020/01/23 0F ,
< >

For each thread the following information is displayed: thread id, thread name, dump flags, dump error
status, thread exit status, thread creation time, exit time, kernel time, user time, thread start address
and thread processor affinity.

413 Thread Names

The Thread Names page displays the contents of the ThreadNamesStream minidump stream.
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[ Minidump Browser x86 _ o «®
File Help

Summary Threa..." | Name

Comments 7840  CereateMiniDumpAppMainThread
Handles 22293 second Thread
Handle Operation
Memaory

Memary Info 17020| Fourth Thread
Misc Info 13012 | Fifth Thread
Modules

Tokens

Threads

Thread Info

System Info

System Memary Info
Unloaded Modules
VM Counters

19376 Third Thread

For each thread the thread id and thread name is listed. We use this information to provide thread names
on appropriate other minidump displays.

414 System Info

The System Info page displays the contents of the SystemInfoStream minidump stream.

['] Minidump Browser x36 - m} ®
File Help
Sumeary Name Value Raw Value
Comments
Exception Processor
Handles Processor architecture xB6. o
Handle Cperation Processor level Pentium Pro / Pentium I 6
Memaory
Memary Info Processor revision Maodel Ox3c Stepping 0x03 303
Misc Info Humber of processors 8
Modules
Tokens
Threads Product
Thread Info Product type Workstation 1
Thread Names
Version 10,0 Build 19042 (Windows 10} 10.0
System Memary Info Build Number 19042
Unloaded Modules Flatform VER_PLATFORM_WIN32_NT 2
VM Counters
Service Pack
Suite Mask Remote Desktop RTS (100
CPU
Vendor Genuinelntel 75666547 (nd9656e69 OnbeB5T46e
Version Model 0x003¢ Family 00006 Type 0 Stepping: 0n3 Ox000306¢3
Features FPU, VME, DE, PSE, TSC, MSR, PAE, MCE, CXB, APIC, SEF, MTRR, PGE, Onblebfbff

This page provides information about the computer hardware and the operating system you are using.
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415 System Memory Info

The System Memory Info page displays the contents of the SystemMemoryInfoStream minidump

stream.

25

['] Minidump Browser x36 m}

File Help

Summary Name Value Raw Value

Comments
Revision 1
Flags FILECACHE, BASICPERF, DIRTYPAGES, RESIDENTAVAILABLEPAGES 000!
Basic Information
TimerResolution 156,250 | 0xD0026250
PageSize 4.00 KB 0w00001000
NumberOfPhysicalPages 4,158,641 00037401
LowestPhysicalPageNumber 1/ 0x00000001
HighestPhysicalPageNumber 4,324,863 | (w0041 foiff
AllocationGranularity 64,00 KB 000010000
MinimumUserModeAddress 0x0000000000010000
MaximumUserModeAddress CD0000000T T efFT
ActiveProcessorsaffinityMask x0000D000D00000T
NumberOfProcessors B/ 000000008
File Cache Information
CurrentSize 472.32 MB| 0w000000001 4851000
< 3

This page provides detailed information about the memory state of the system.

416 Unloaded Modules

The Unloaded Modules page displays the contents of the UnloadedModuleListStream minidump stream.

['] Minidump Browser x86

File Help

Summary [+] Display module path

Comments

B Image Base '_'ISIzn |Cheehsum Timestamp Module

Handles OxEASFO000 2.05 MB| (wD0214d51 2036/07/13 07:30:31 | WMV Core.DLL

Handle peration OxGAJB0000 244,00 KB|  OMOODM6054 1980/10/14 09:27:24 | WMASF.DLL

Memary

Memery Info OxBABAD000  1.02MB|  Ow0O010dTS0| 2056/01/21 07:4%:50 | mfperthelper.dil

Misc Info OxGAD20000  560.00 KB Ox0009321a  2094/07/22 14:23:07  wpdshext.dil

:“‘*‘“ Ox73A30000 141 ME| [xD01726ab| 2042/08/19 11:56:39 | gdiplus.dil

Threads Ox75C20000 24.00KB  OwDOD07ede| 2092/11/08 18:13:28 | psapi.dil

Theead Info 75C20000 24,00KE|  OwDODOTede 2002/11/08 18:13:28 | psapi.dil

Treead Names 0x75C20000 24.00KB| 0x00007e3e 2092/11/08 18:13:28 | psapl.dil

System Info ! psapl

System Memary [nfo OxGAD40000 396.00 KB|  OwDOOSIFS9| 2067/05/25 13:31:08 | verifier.dll
Ox75C20000 24.00KE| Ox00007e3de 2092/11/08 18&13:28  psapi.dil

VM Counters
Ox75C20000 24,00KB|  OMOODD7e3e 2092/11/08 18:13:28 | psapi.dil
Ox75C20000 24.00KB| 0x00007ede 2002/11/08 18:13:28 | psapl.dil
Ox75C20000 24.00KE| Ox00007e3e 2092/11/08 18:13:28  psapi.dil
Ox75C20000 24.00KE| Ox00007ede 2092/11/08 18:13:28  psapi.dil
Ox75C20000 24,00KB|  Ow0ODOTede 2082/11/08 18:13:28 | psapi.dil
Ox75C20000 24.00KB|  Ow00DOTe3e 2092/11/08 18:13:28 | psapl.dil
Ox75C20000 24.00KE| Ox00007e3e 2092/11/08 18:13:28  psapi.dil
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417

For each module in the minidump that has been unloaded this page displays the following information, dll
load address (image base), size, checksum, timestamp, module name (with optional path).

VM Counters

The VM Counters page displays the contents of the ProcessVmCountersStream minidump stream.

['] Minidump Browser x86
File Help

Summary
Comments
Exception
Handles

Handle Operation
Memory

Memery Info

Misc Info

Modules

Tokens

Threads

Thread Info
Thread Names
System Info
System Memory Info
Unloaded Modules

- O ®
Name Value Raw Value G
Revision 2
Working Set

Page Fault Count
Peak Working Set Size

Working Set Size

Quota

CQuota Peak Paged Pool Usage
Quoata Paged Pool Usage

Quota Peak Non Paged Pool Usage
Quota Mon Paged Paol Usage

Page File

Page File Usage
Peak Page File Usage
Private Usage

<

22,778
18.48 MB
18.48 MB

235,34 KB
202,74 KB
53.35KB
53.09 KB

7.33 MB
7.39 MB
7.39MB

This page provides detailed information about the virtual memory counters of the system.
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